
CONCEPT-II

CONCEPT-II is a frequency domain method of moment (MoM) code, under development 
at the Institute of Electromagnetic Theory at the Technische Universität Hamburg-Harburg 
(www.tet.tuhh.de).

 

Overview of demo examples

 The following demonstration examples for CONCEPT-II will be discussed in 
detail ($CONCEPT: home directory of the package): 

1.  Wire loop, directory $CONCEPT/demo/example1-wire-loop

2.  Cylindrical monopole antenna radiating over a finite ground plate, 
directory  $CONCEPT/demo/example2-monopole-on-plate

3. Box with aperture and internal radiator, directory 
$CONCEPT/demo/example3-box-with-aperture

4.  Dielectric sphere in a plane wave field, directory 
$CONCEPT/demo/example4-dielectric-sphere

In order to find out how CONCEPT-II works it is recommended to start with the example 1 
(wire loop)

Important: file names should never contain blanks. 

Shortcuts: Help → Navigation
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http://www.tet.tu-harburg.de/


Example 2: Cylindrical monopole antenna
radiating over a finite ground plate

It is assumed that the user is already familiar with example 1.

It is recommended to start from an empty directory and set up the simulation 
according to Fig 2.

$CONCEPT/demo/example2-monopole-on-plate 
A thick monopole antenna on a square ground plate in free space shall be investigated. All 
dimensions can be taken from Fig 1.

The antenna is formed by a cylinder of 0.5 m height. A wire (length 2 cm, radius R = 0.5 
mm) serves as connection between cylinder and plate. A power generator at the lower end
of the wire is feeding the structure with 1 W. A frequency loop shall be considered from 
10,...,300 MHz.
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Fig 1: Geometry of the structure under investigation
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As there is geometrical symmetry and electrical symmetry, only one quarter of the 
structure needs to be discretized (1. quadrant). The x-z plane and the y-z plane are planes
of magnetic symmetry.

Two surface patch files need to be generated which are called plate.surf and  antenna.surf 
in the example. The wire connecting the bottom of the cylinder with the plate is contained 
in the file generator.wire. Notice the corresponding file names in the simulation project 
tree, see left side of GUI,  Fig 2 (section 'Project View'). 

A structure as depicted in the display area of the GUI according to Fig 2 has to be 
discretized first.  
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Fig 2: In the display area we see the discretized structure according to Fig 1. Note that only the 
symmetric parts need to be considered setting up the numerical model.  



Discretizing  the finite ground plate

Activate:  CAD tools → Cad tools 2. Click on   .  The window of the plate tool opens 

(Fig 3):

Here a frequency a frequency of 600 MHz (‘Frequency in MHz:’) in combination with 8 
basis functions per wavelength (‘No bf/wl) is applied to generate the surface patch grid. 
This frequency is far higher than the max. frequency according to the problem definition 
(300 MHz, see above). 

By setting an appropriate combination of frequency and number of patches per wavelength
a suitable grid can be adjusted.  Here, clicking on Compute meshes gives a 7 by 7 
element mesh. Clicking on OK provides the surface patch file plate.surf  (‘Output file...’). In
the general case the plate tool plate can discretize arbitrary plates with four (or three) 
vertices. 

Near the feed region which is at  (0m, 0m, 0m)  a rapid variation of the antenna near field 
and of the surface current distribution have to be expected. Hence the grid should be 
refined in this region. Select a preview pattern in the 'Mesh refinement' section of the Cad 
tools 1 card. 
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Fig 3: Creating the mesh of a 0.4 m x 0.4 m plate at 600 MHz with 8 basis 
functions per wavelength. Using 8 to 10 basis functions per wavelength is a well-
known rule of thumb  for electrically large structure parts.  



Choosing  means that in our case quadrangles can be selected by right clicks. 
Each quadrangle will be subdivided into 4 smaller quadrangles. 

Selected patches are marked by preview patterns. It is suggested that four patches near 
the bottom left corner, i.e. near the antenna feed point, should be marked as illustrated in
Fig 4.

Clicking on  or typing 'e' results in the mesh according to Fig 5 . Note that triangles are

generated in the transition region. Each node of a patch is connected to the nodes of all 

adjacent patches. An overall triangular mesh can easily be generated now, click on  
(tool bar)
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Fig 4: Local mesh refinement close to the antenna feed point, see  Fig 2

Fig 5: Mesh refinement near the bottom left corner near (0, 0, 0)m



Creating the cylinder

Activate CAD tools, then  click on  (tool bar).  The following window opens:

In order to get an appropriate mesh the 'Number of patches per wavelength' has been set 
to 12 and the frequency to 600 MHz, although the maximum applied frequency is only 300 
MHz. Magnetic symmetry with respect to the y-z plane and the x-z plane has been 
specified. Hence only a quarter of a cylinder is generated when pressing OK. 

Creating the wire 

The wire could be easily introduced as has been described in example 1, simply be 
entering the coordinates (0,0,0), (0,0,0.02) under Simulation → Wires → New wire file. 
Another way of generating wires is as follow:  Click on the 'Wires' radio button in the Cad 
tools 1 section. The 'Add' button will be activated automatically:
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Fig 6: Only a quarter of a full cylinder will be discretized when clicking on OK or Apply



Now select two nodes as illustrated in Fig 7  by right clicking on the respective nodes. A 
node is ready to be selected once the mouse pointer is turned into a cross. 

Clicking on  or typing 'e' gives the following sub-window, enter the respective data.

OK creates the wire file generator.wire .

Load the structure into the simulation: Activate the Simulation tab → right click on the top 
entry → select Load all files from 'CAD'.

Set the check marks for 'Magn. symmetry, XZ plane' and  'Magn. symmetry, YZ plane'

Frequency sampling

How to do this is indicated in Fig 2. Right click on Frequencies >  Frequency loop for a 
special interval. The shown sub-window opens. Enter the sampling data and click on 
Generate values list. Only frequency steps appearing in the list on the right side will be  
considered in the simulation. 
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Fig 7: Two patch nodes have been selected be right mouse clicks for 
introducing a wire

Fig 8: Change the default entries to the ones shown here



Excitation

Right click on  Excitation → Ports (power input/voltage input) → Port(s) on 
genrator.wire → Set ports → enter wire number 1 and 1 W (see Fig 9)  

The wire where to place the port can also be selected by a right click. 

In general ports (loads, voltage probes, current probes, voltage generators) can be placed 
at the end, center, or at the beginning of a wire. 

Checking geometry, starting of the simulation

Once it is ensured that all data is correct the simulation can be started: . 

As a frequency loop has been specified it may take a while for the back end to finish. Note 
that a linear system of equations has to be set up and solved for each frequency step. If 
not sure how the MoM works refer to Section 4 of the User's manual.

Sometimes it is advantageous to proceed as follows before starting the simulation:

Simulation (see menu bar)→ Run simulation front-end. 

Notice the output in the message section under the display area (number of unknowns, 
size of system matrix etc.) 

Post processing → 'Show complete structure'  

Generally all wires are combined into wire.0 and all surfaces into surf.0 . Note that by 
hovering the mouse pointer over a node or a patch all available information is printed in a 
special line under the display area.
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Fig 9: Right-clicking on the Excitation  item provides the possibility 
to switch to a different type of excitation



Displaying the surface current distribution

For displaying the current distribution (back end has finished):

- Go to Post processing (see Fig 10 )

- Click on 

- Enter the values according to Fig 10, the current distribution at 300 MHz has been           
selected for representation

Pressing OK provides the structure with current distribution at 0° in the display area. A 
certain scaling is necessary in order to obtain a view according to Fig 11. Vector and arrow
scaling has already been explained in example 1 for the case of a 2D field distribution.

In order to validate the result, the power budget shall be investigated. Since lumped loads 
(resistors) have not been introduced and the whole structure under investigation includes 
only perfect conductors the input power should be completely radiated. In other words: the 
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Fig 10: Window for controlling the current distribution to be 
displayed. It is recommended to enter 16 phase intervals for a movie.

Fig 11: Computed current distribution at 300 MHz
(phase: 0°)



computed surface current distribution should be able to radiate the input power of 1 W. Of 
course, this can be achieved only up to a certain degree in a numerical simulation. For the 
determination of the radiated power it is necessary to compute a 3D radiation diagram.

Creating a 3D radiation diagram

- Go to Post processing

- Click on .  A sub-window as depicted in Fig 12 shall be computed

In our case we have chosen All frequencies. Hence a 3D pattern will be computed for 

each frequency step. 

Choosing a sufficient number of elements in theta and phi direction is important to resolve 
all lobes that in general might appear (imagine a grid on a unit sphere, the far field is 
computed at each intersecting point). Multiply clicking on Step shows the development of 
the 3D radiation diagram as a function of frequency.

Click the Log data tab → 3D rad. Diagram. This gives numerical data with respect to the  
diagram computation in the display area. 

Example values, computation by the power flow in the far field (Poynting vector):

10 MHz, radiated power: 0.976 W 

300 MHz, radiated power: 0.999 W 

A deviation of 5% between input power and radiated power can be tolerated for a loss-less
structure in practical situations. 

Note that computed values are always given in [V]. Divide a diagram value by the distance
in the far field region and get the E field strength in the chosen direction!
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Fig 12: The electric far field shall be computed 



Hint: to quickly get back to the already computed surface current distribution at this stage 
of post processing, click as follows:

Current/Charge distribution → Show results

The input impedance as a function of frequency 

- Go to Post processing

- Click on . A sub-window as shown in Fig 13 opens.

The input impedance of the port generator has automatically been stored. OK provides the
magnitude in the display area as a function of frequency.

For an enhanced representation click (‘View resulzs’ section)  Freq.-domain responses 
→ show results in the post processing tree. This opens the CONCEPT-II gnuplot front 
end. Change the default entries to the entries as shown in Fig 14 and click Run gnuplot .
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Fig 13: Window for the selection of system responses to be displayed as a function of frequency



The following curves are  displayed: 
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Fig 14: The real and the imaginary part of the antenna input impedance shall be plotted (columns 2
and 3 of the ASCII data file port-zin1.asc; column 1 is the frequency)



As could be expected we have a large negative imaginary part and a very small positive 
real part at the low frequency end. 
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Fig 15: The complex input impedance as a function of frequency


